




 

 

1 Методические указания по проведению лекционных занятий  

 

Лекционные занятия в высшем учебном заведении являются основной формой 

организации учебного процесса и должны быть нацелены на выполнение ряда задач:  

- ознакомить студентов со структурой дисциплины; 

- изложить основной материал программы курса дисциплины; 

- ознакомить с новейшими подходами и проблематикой в данной области; 

- сформировать у студентов потребность к самостоятельной работе с учебной, 

нормативной и научной литературой. 

Лекционное занятие представляет собой систематическое, последовательное, 

монологическое изложение преподавателем-лектором учебного материала, как правило, 

теоретического характера.  

Цель лекции – организация целенаправленной познавательной деятельности 

студентов по овладению программным материалом учебной дисциплины.  

Чтение курса лекций позволяет дать связанное, последовательное изложение 

материала в соответствии с новейшими данными науки, сообщить слушателям основное 

содержание предмета в целостном, систематизированном виде.  

В ряде случаев лекция выполняет функцию основного источника информации, 

когда новые научные данные по той или иной теме не нашли отражения в учебниках. 

Организационно-методической базой проведения лекционных занятий является 

рабочий учебный план направления подготовки. При подготовке лекционного материала 

преподаватель обязан руководствоваться учебными программами по дисциплинам 

кафедры, тематика и содержание лекционных занятий которых представлена в рабочих 

программах, учебно-методических комплексах.  

При чтении лекций преподаватель имеет право самостоятельно выбирать формы и 

методы изложения материала, использовать различные технические средства обучения. 

Рекомендации по работе студентов с конспектом лекций.  

Изучение дисциплины студенту следует начинать с проработки рабочей 

программы, особое внимание, уделяя целям и задачам, структуре и содержанию курса. 

При конспектировании лекций студентам необходимо излагать услышанный 

материал кратко, своими словами, обращая внимание, на логику изложения материла, 

аргументацию и приводимые примеры. Необходимо выделять важные места в своих 

записях. Если непонятны какие-либо моменты, необходимо записывать свои вопросы, 

постараться найти ответ на них самостоятельно. Если самостоятельно не удалось 

разобраться в материале, впоследствии необходимо либо на следующей лекции, либо на 

лабораторном занятии или консультации обратиться к ведущему преподавателю за 

разъяснениями.  

Успешное освоение курса предполагает активное, творческое участие студента 

путем планомерной, повседневной работы. Лекционный материал следует просматривать 

в тот же день. Рекомендуемую дополнительную литературу следует прорабатывать после 

изучения данной темы по учебнику и материалам лекции. 

Каждая тема имеет свои специфические термины и определения. Усвоение 

материала необходимо начинать с усвоения этих понятий. Если какое-либо понятие 

вызывает затруднения, необходимо посмотреть его суть и содержание в словаре 

(Интернете), выписать его значение в тетрадь для подготовки к занятиям. 

При подготовке материала необходимо обращать внимание на точность 

определений, последовательность изучения материала, аргументацию, собственные 

примеры, анализ конкретных ситуаций. Каждую неделю рекомендуется отводить время 

для повторения пройденного материала, проверяя свои знания, умения и навыки по 

контрольным вопросам и тестам. 

 



 

 

2 Методические указания по практическим работам  

 

Изучение дисциплины «Организационное обеспечение автоматизированных 

систем» предполагает посещение обучающимися не только лекций, но и лабораторных 

работ. Лабораторные работы со студентами предназначены для проверки усвоения ими 

теоретического материала дисциплины. 

Основные цели лабораторных работ: 

- закрепить основные положения дисциплины; 

- проверить уровень усвоения и понимания студентами вопросов, рассмотренных 

на лекциях и самостоятельно изученных по учебной литературе; 

- научить пользоваться нормативной и справочной литературой для получения 

необходимой информации о конкретных технологиях; 

- оказать помощь в приобретении навыков расчета точностных характеристик; 

- восполнить пробелы в пройденной теоретической части курса и оказать помощь в 

его усвоении. 

Для контроля знаний, полученных в процессе освоения дисциплины на 

лабораторных занятиях обучающиеся выполняют задания реконструктивного уровня и 

комплексное практическое задание.  

Целью выполнения задания реконструктивного уровня и комплексного задания  

студентами является систематизация, закрепление и расширение теоретических знаний, 

полученных в ходе изучения дисциплины.  

Ниже приводятся общие методические указания, которые относятся к занятиям по 

всем темам: 

- в начале каждого лабораторного занятия необходимо сформулировать цель, 

поставить задачи; 

- далее необходимо проверить знания студентами лекционного материала по теме 

занятий; 

- в процессе занятия необходимо добиваться индивидуальной самостоятельной 

работы студентов; 

- знания студентов периодически контролируются путем проведения текущей 

аттестации (рубежного контроля), сведения о результатах которой доводятся до студентов 

и подаются в деканат;  

- время, выделенное на отдельные этапы занятий, указанное в рабочей программе, 

является ориентировочным; преподаватель может перераспределить его, но должна быть 

обеспечена проработка в полном объеме приведенного в рабочей программе материала; 

- на первом занятии преподаватель должен ознакомить студентов с правилами 

поведения в лаборатории и провести инструктаж по охране труда и по пожарной 

безопасности на рабочем месте; 

- преподаватель должен ознакомить студентов со всем объемом лабораторных 

работ и  требованиями, изложенными выше; 

- преподаватель уделяет внимание оценке активности работы студентов на 

занятиях, определению уровня их знаний на каждом занятии. 

На лабораторных работах решаются задачи из всех разделов изучаемой 

дисциплины.  
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Практическая работа №1 

Теоретическое введение в предметную область 
  

 Настоящий курс лабораторных работ ориентирован на 

изучение CASE - средств на примере диаграмм, создаваемых для 

проекта «Служба занятости в рамках вуза». Процесс создания 

диаграмм начинается с этапа изучения предметной области, которая 

описывается в этой лабораторной работе. 

  

 1. Описание системы 

  

 Система предназначена для того, чтобы помочь студенту 

устроиться на работу уже в процессе его обучения в вузе. Подав 

заявление в систему, студент становится ее клиентом и начинает 

обслуживаться на протяжении всего обучения в вузе. Заявление 

представляет собой анкету. Система предлагает профессиональные 

(основанные на изучаемых предметах), психологические 

тестирования, проводимые регулярно (раз в семестр (полгода). 

 Особое внимание уделяется обучению студента, по итогам 

успеваемости составляются экспертные оценки. На основе собранной 

информации составляется резюме, представляющее собой полную 

характеристику человека. Это резюме отсылается всем организациям, 

имеющим необходимые вакансии. 

 Основным назначением системы является автоматизация 

ввода и хранения отчетных данных по студентам, составления 

характеристик и резюме, поиска вакансий в фирмах. Система 

позволяет изменять, дополнять, вести поиск и просмотр информации 

о студентах, накладывать ограничения доступа к системе, хранить 

списки студентов, закончивших обучение, в виде архива, 

контролировать выдачу студенту заданий на курсовые работы и 

проекты, связывать институт с фирмами, заинтересованными в 

поиске сотрудников. 

 Также данная система может быть использована для 

составления отдельных списков групп, для печати зачетных 

ведомостей, для печати полной базы данных и для статистики. 

  

 

 Система состоит из четырех подсистем: 

 • контроля успеваемости студентов; 

 • профессиональных и психологических тестов; 

 • обработки запросов, определения категорий полномочий 

пользователей; 

 • экспертных оценок. 

  

 1.1. Подсистема контроля успеваемости студентов 

  

 Эта подсистема является частью системы «Служба занятости в 

рамках вуза», которая отвечает за статистическую отчетность по 

успеваемости отдельного студента, группы или целого факультета, а 

также за хранение и правильность ее ввода. 

 Входными данными подсистемы являются: оценки, даты сдачи 

экзаменов, имена студентов, номера групп, факультет. На выходе 

подсистема выдает обработанные данные: средний балл по студенту, 

группе или факультету, процентное соотношение оценок у студента в 

группе или на факультете, имена и количество стипендиатов в группе 

или на факультете. 

 Подсистема «Контроль успеваемости студентов» может 

функционировать отдельно от всей системы, что дает возможность 

установить и использовать ее независимо, если это необходимо. 

 Подсистема «Контроль успеваемости студентов» включает 

следующие функции: 

 • ввод, вывод и редактирование информации по 

информационным объектам подсистемы; 

 • сохранение информации, поступившей от подсистемы 

контроля успеваемости студентов; 

 • расчет процентного соотношения оценок у студента в группе 

или на факультете и вывод его в виде таблиц, графиков и диаграмм; 

 • расчет среднего балла по студенту, группе или факультету; 

 • формирование данных по студенту, группе или факультету; 

 • выявление сильнейших и слабейших студентов в группе или 

на факультете; 

 • расчет количества стипендиатов в группе или на факультете; 

 • проверку правильности ввода данных. 
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 1.2. Подсистема профессиональных и психологических 

тестов 

  

 
 

Рисунок 1. Подсистема профессиональных и психологических тестов 

 

 1. Ф.И.О., новые тесты, название теста. 

 2. Ответы на тесты. 

 3. Вопросы, результаты теста, Ф.И.О. 

 4. Ответы, Ф.И.О., название теста. 

 5. Новый тест. 

 6. Ф.И.О., название теста. 

 7. Результаты теста, Ф.И.О. 

 8. Ф.И.О., специальность. 

 9. Ф.И.О., набор тестов. 

 10. Ф.И.О., профессионально-психологический тест, 

психологический тест, специальный тест, ответы. 

 11. Ф.И.О., информация о пройденных тестах. 

 12. Ф.И.О., набор тестов для клиента. 

Внешние сущности 

Фирма Тип производственного объединения предприятия. 

В данной ситуации фирма выступает как 

работодатель. Она отправляет запрос на 

специалиста. 

 

Клиент Человек, поступивший учиться в институт и 

пользующийся услугами СЛУЖБЫ ЗАНЯТОСТИ 

для нахождения работы. Клиент получает 

запрос на проведение профессионального, 

психологического и специального тестов 

и вопросы тестов. Затем КЛИЕНТ отправляет 

входные данные, ответы на вопросы тестов, 

запрос на результаты тестов. 

Архив Хранилище, где хранятся все данные о клиенте, 

начиная с момента пользования услугами 

СЛУЖБЫ ЗАНЯТОСТИ. 

Дополнительные 

источники 

Источники, из которых поступают новые, более 

современные тесты. Это INTERNET, журналы, 

какие-либо специализированные центры. 

 

 Работа модулей подсистемы 

 Монитор - вызывает модуль ввода и получает от него данные 

для выполнения дальнейших задач; обращается к модулю 

тестирования, передавая ему исходные данные; после выполнения 

своей задачи тестирование передает ему свои результаты; вызывает 

модуль вывода и получает от него конечный результат. 

 Ввод - получает запрос от монитора, передает ему 

запрашиваемые данные. 

 Вывод - вызывается монитором и получает от него результаты, 

выводя их на дисплей. 
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 Тестирование - вызывается монитором, получает от него 

исходные данные и в зависимости от них обращается к тому или 

иному модулю. Выполнив свои функции, модули посылают 

тестированию результаты действий, а тестирование уже передает 

полученные результаты монитору. 

 Проверка - получает исходные данные от тестирования и 

передает их своим подмодулям: регистрация тестируемых, 

определение тестов. Подмодули передают полученные результаты 

модулю проверки. Тестирование (профессиональное, 

психологическое, специальное) получает исходные данные от модуля 

тестирования и передает их своим подмодулям: профессиональное, 

психологическое, специальное тестирование. Подмодули передают 

полученные результаты. 

 Обработка - получает данные от тестирования, выполняет свои 

задачи и возвращает полученные результаты модулю тестирования. 

 Просмотр - получает данные от модуля тестирования, 

выполняет свои задачи и посылает полученные результаты модулю 

тестирования. 

  

 1.3. Подсистема обработки запросов, определения 

категорий пользователей 

 Данная подсистема предназначена для определения категории, 

полномочий и обработки запросов пользователей службы занятости. 

В частности, она выполняет следующие функции: 

 • регистрацию новых фирм; 

 • регистрацию новых студентов; 

 • определение прав доступа зарегистрированного 

пользователя; 

 • обработку запросов; 

 • прием регистрационных данных от фирм; 

 • прием регистрационных данных от студентов; 

 • прием регистрационных данных от обслуживающего 

персонала; 

 • составление резюме; 

 • запись данных в БД студентов; 

 • запись данных в БД фирм; 

 • запись данных в БД зарегистрированных пользователей. 

 В соответствии с выполняемыми функциями система работает 

со следующими 

данными: 

 • регистрационными данными студентов; 

 • регистрационными данными фирм; 

 • личными данными студентов; 

 • информацией о студентах (получаемой фирмами); 

 • информацией о фирмах (получаемой студентами); 

 • идентификационными данными пользователей; 

 • информацией о системе; 

 • запросом; 

 • служебной информацией (для обслуживающего персонала); 

 • результатом психологического теста; 

 • результатом профессионального теста; 

 • экспертными оценками. 
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Рисунок 2. Подсистема обработки запросов, определения категорий 

пользователей 

 Определение категории - модуль, определяющий категорию 

пользователя. 

 Определение полномочий - модуль, определяющий 

полномочия пользователя. 

 Обработка запроса - модуль, предназначенный для обработки 

запросов пользователя. 

 Выполнение запроса - модуль, предназначенный для 

выполнения запросов пользователя. 

 Запись в БД зарегистрированных пользователей - модуль, 

предназначенный для работы с базой данных зарегистрированных 

пользователей. 

 Запись в БД студентов - модуль, предназначенный для работы 

с БД студентов. 

 Запись в БД фирм - модуль, предназначенный для работы с БД 

фирм. 

  

 1.4. Подсистема экспертных оценок 

 

 Эта подсистема предназначена для установки и просмотра 

экспертной оценки. Она дает краткую информацию преподавателю о 

студенте или группе. Студент может с помощью ее ориентироваться 

в учебе. 

 Кроме того, подсистема может дать представителю фирмы 

некоторое представление о студенте для рассмотрения его в качестве 

новых кадров. 

 Подсистема является как информационной средой, так и 

средой установки экспертной оценки. 

 Определение статуса клиента 

 • Клиент входит в подсистему с идентификационным 

номером. По номеру присваивается уровень доступа. Подсистема 

выдает меню работы, соответствующее уровню доступа. 

 Обработка отчетного задания 

 • Эксперт: посылает запрос на предоставление информации о 

студенте (группе), результатах тестирования. Из общей БД поступает 

успеваемость студента (группы), результаты тестирования. Делает 

запрос на критерии. Из хранилища критериев поступают критерии 

для установки экспертной оценки. Вводит экспертную оценку. 

Делает запрос на просмотр экспертной оценки. Из общей БД 

поступает экспертная оценка. 

 

 

 
Рисунок 3. Подсистема экспертных оценок 

 

  

 • Студент: посылает запрос на предоставление информации об 

успеваемости, результатах тестирования. Из общей БД поступает 

информация об успеваемости студента, результаты тестирования. 

Делает запрос на просмотр экспертной оценки, которая поступает из 

общей БД. 

 • Представитель фирмы: делает запрос на просмотр 

экспертной оценки, которая поступает из общей БД. 

 Свертка: модуль, получающий из временной БД экспертные 

оценки, проводит их обработку и передает обработанные данные в 

общую БД. 



9 

 Общая база данных содержит в себе: 

 • экспертные оценки (предоставляются подсистемой 

экспертных оценок), 

 • успеваемость студента (предоставляется подсистемой 

контроля студенческой успеваемости), 

 • успеваемость группы (предоставляется подсистемой 

контроля успеваемости) 

 • результаты профессионального теста (предоставляются 

подсистемой профессиональных и психологических тестов), 

• результаты психологического теста (предоставляются подсистемой 

профессиональных и психологических тестов). 

 Временная база данных содержит в себе экспертные оценки 

(поставленные экспертом). 

 Критерии экспертных оценок 

 • По 5-балльной системе оценить студента в начале, середине, 

конце семестра. 

 • По 5-балльной системе оценить степень запоминания курса 

студентом в начале, середине, конце семестра. 

 • По 5-балльной системе оценить степень применения знаний 

студентом в начале, середине, конце семестра. 

 

 2. Модульная структура системы 

 

 1. Запрос, имя, уровень доступа. 

 2. Диаграммы, графики, списки, ведомости, количество 

стипендиатов, отчеты об успеваемости. 

 3. Имя, личные данные студента, запросы на экспертные 

оценки. 

 4. Данные студента. 

 5. Данные студента, данные фирмы, запросы, оценки, пароль, 

имя, уровень доступа. 

 6. Отчеты, резюме, графики, вопросы тестов. 

 7. Уровень доступа. 

 8. Имя. 

 9. Пароль. 

 10. Полномочия. 

 11. Резюме. 

 12. Результаты тестов. 

 13. Запрос. 

 14. Найденные записи. 

 15. Экспертные оценки. 

 
Рисунок 4. Модульная структура системы 

  

 3. Информационные объекты системы 

 

 Под информационным объектом хранения (информационным 

элементом) понимается логически однородная единица информации, 

для хранения которой достаточно одной записи таблицы. 

 Информационные объекты хранения для БД системы: 

 А. Общего назначения: 

 1. Факультет. 

 2. Учебная специальность. 

 3. Группа студентов. 
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 4. Студент. 

 5. Преподаватель. 

 6. Учебный предмет (дисциплина). 

 7. Тип отчетного задания (курсовой проект, реферат, 

контрольная работа, зачет, экзамен и т. д.). 

 8. Отчетное задание по конкретному изучаемому предмету – 

описание сути отчетного задания и необходимых требований для его 

успешного выполнения. 

 9. Отчетное задание, сданное конкретным студентом, - 

экземпляр отчетного задания. 

 10. Экспертная оценка успеваемости студента - кумулятивная 

оценка успеваемости студента по предмету (например, за семестр). 

 11. Экспертная оценка успеваемости группы студентов - 

аналогично предыдущему, 

но по целой группе. 

 12. Контрольный вопрос для контроля студентов по 

изучаемым дисциплинам. 

 13. Ответ студента на контрольный вопрос 14. 

Правильный ответ контрольного вопроса. 

 15. Вопрос профессионального теста. 

 16. Ответ студента на вопрос профессионального теста 

(правильный или нет). 

 17. Правильный ответ профессионального теста. 

 18. Вопрос психологического теста. 

 19. Вариант ответа на вопрос психологического теста. 

 20. Правильный вариант ответа. 

 21. Ответ студента на вопрос психологического теста. 

 22. Экспертная оценка по результату профессионального 

теста. 

 23. Экспертная оценка по результату психологического теста. 

 24. Почтовое сообщение - сообщение по электронной почте.  

 25. Объявление. 

 26. Резюме (характеристика) студента. 

 27. Архивная запись по группе студентов. 

 28. Архивная запись по студенту. 

 29. Архивная запись отчетного задания, сданного студентом. 

 30. Архивная запись экспертных оценок. Каждая экспертная 

оценка соответствует отчетному заданию. 

 31. Архивная запись результатов профессионального теста. 

 32. Архивная запись результатов психологического теста. 

 33. График успеваемости студента (зависимость средней 

оценки от временного промежутка). 

 34. График успеваемости группы студентов. 

 35. Архивная запись графиков успеваемости группы 

студентов. 

 Б. Служебные: 

 1. Запись об активном соединении. 

 2. Запись о пользовательской транзакции. 

 3. Уровень доступа в систему. 

 4. Учетная запись полномочий пользователя (для организации 

зашиты от несанкционированного доступа). 

 

 4. Функциональные характеристики системы 

  

 1. Первоначальный ввод информации в БД. 

 2. Изменение содержания БД: 

  • ввод новых данных, 

  • изменение существующих данных, 

  • архивация данных. 

 3. Осуществление поиска в БД по запросу пользователя. 

 4. Удаленный доступ к системе по протоколу TCP/IP. 

 5. Обеспечение защиты и безопасности данных, в частности: 

  • разграничение прав доступа к ресурсам сервера 

(владелец, группа и т. д.), 

  • контроль вводимой информации, 

  • обеспечение целостности БД. 

 6. Вывод найденной информации. 

  

 5. Цели и задачи системы 

 

 Система будет обеспечивать хранение, выдачу и обновление 

информации системы дистанционного обучения студентов и системы 

«Служба занятости в рамках вуза», а именно: 



11 

 • обеспечивать информационную поддержку системы 

дистанционного обучения студентов; 

 • представлять и получать накопленную информацию по 

конкретным объектам; 

 • представлять и получать информацию от подсистемы 

обработки запросов пользователей; 

 • представлять и получать информацию от подсистемы 

контроля студентов по изучаемым на кафедре дисциплинам; 

 • обеспечивать разграничение доступа к информационным 

ресурсам системы; 

 • обеспечивать мониторинг активных и пассивных 

пользователей и системных событий; 

 • обеспечивать пользователей возможностью 

информационного обмена; 

 • обеспечивать связь между фирмами и службой (институтом); 

 • обеспечивать регулярное прохождение студентами 

профессиональных и психологических тестов; 

 • обеспечивать поиск данных по запросам. 

 

 6. Категории пользователей 

 

 При работе с системой на стадиях заполнения эксплуатации 

БД необходимо участие следующих категорий пользователей: 

 • администратора БД, 

 • группы экспертов. 

 Администратор системы осуществляет заполнение БД 

информацией, подготовленной учебной частью, деканатом или 

группой экспертов. Внесение изменений в БД системы 

осуществляется лишь администратором системы под руководством 

группы экспертов. Преподаватели и студенты являются внешними 

пользователями, работающими с системой в соответствии с ролями 

доступа в информационно-поисковом режиме. 

 Предоставляемые возможности пользователям системы 

студенту: 

 • ввод личных анкетных данных; 

 • просмотр экспертных оценок по отчетным заданиям и 

результатам тестов; 

 • прохождение психологических и профессиональных тестов; 

 • просмотр сводных таблиц и графиков; 

 • получение и сдача контрольных заданий; 

 • доступ к справочным материалам (данные из службы 

удаленного обучения, а именно методическое обеспечение); 

 • просмотр сообщений и внесение изменений в сообщения 

доски объявлений; 

 • поиск вакансии в БД по запросу; 

 эксперту (преподавателю): 

 • предоставление экспертной оценки, а также изменение ее; 

 • просмотр других оценок; 

 • просмотр программы курса и внесение изменений в нее; 

 • ввод контрольных заданий и назначение их студенту; 

 • контроль ответов на задания; 

 • доступ к интеллектуальным ресурсам; 

 • составление резюме (характеристик); 

 деканату (декану, зам. декана и т. д.): 

 • просмотр программы курса; 

 • просмотр динамики успеваемости курса, группы, отдельного 

студента; 

 • просмотр сводных таблиц и графиков; 

 • просмотр экспертных оценок и характеристик 

преподавателей; 

 администратору: 

 • определение прав доступа; 

 • ввод и корректировка системных данных; 

 • контроль работы системы; 

 • осуществление контроля защиты системы от 

несанкционированного доступа; 

 • изменение физической модели данных системы; 

 оператору: 

 • составление сводных таблиц и графиков; 

 • заполнение полей БД системы (ввод информации); 

 фирме: 

 • поиск в БД данных о студенте по запросу; 

 • просмотр резюме студентов. 
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Практическая работа №2 

«Изучение основных функций пакета BPwin» 

 
 BPwin позволяет аналитику создавать сложные модели бизнес-

процессов при минимальных усилиях. BPwin поддерживает три 

методологии - IDEF0, IDEF3 и DFD. Каждая из них призвана решать 

свои специфические задачи. Также можно строить смешанные 

модели. 

 Модель в BPwin рассматривается как совокупность работ, 

каждая из которых оперирует с некоторым набором данных. Работы 

изображаются в виде прямоугольников (блоков), данные - в виде 

стрелок (дуг). 

 При запуске BPWin по умолчанию появляется основная 

панель инструментов, палитра инструментов и Model Explorer. 

  

Таблица 1 

Описание элементов управления основной панели инструментов. 

 

Элемент 

управления 
Описание 

Соответствующий 

пункт меню 

 
Создать новую модель File->New 

 
Открыть модель File-> Open 

 
Сохранить модель File->Save 

 
Напечатать модель File->Print 

 
Выбор масштаба View-> Zoom 

 Масштабирование  View-> Zoom 

 
Проверка орфографии Tools->Spelling 

 

Включение выключение 

навигатора модели 

View-> Model 

Explorer 

 

Включение выключение 

дополнительной панели 

инструментов 

ModelMart 

 

 При создании новой модели возникает диалог, в котором 

следует указать, будет ли создана модель заново, или она будет 

открыта, внести имя модели и выбрать методологию, в которой будет 

построена модель (рисунок 1). 

 BPWin поддерживает три методологии – IDEF0, IDEF3 и DFD. 

В BPWin возможно построение смешанных моделей, т. е. модель 

может содержать одновременно как диаграммы IDEF0, так и IDEF3 и 

DFD. Состав палитры инструментов изменяется автоматически, когда 

происходит переключение с одной нотации на другую. 

 

 
Рисунок 1. 

 

 На основной панели инструментов (либо в любом желаемом 

месте экрана) расположены инструменты редактора BPWin: 
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Рисунок 2.  

 1. Pointer Tool – используется для выбора и определения 

позиции объектов добавленных в диаграмму. 

 2. Activity Box Tool – используется для установки блоков в  

иаграмме. 

 3. Arrow Tool – используется, чтобы устанавливать дуги в 

диаграмме. 

 4. Squiggle Tool – используется для создания тильды (squiggle), 

которая соединяет дугу с ее названием. 

 5. Text Block Tool – используется для создания текстовых 

блоков. 

 6. Diagram Dictionary Editor – открывает диалоговое окно 

Diagram Dictionary Editor, где можно перейти на какую-либо 

диаграмму или создать новую диаграмму. 

 7. Go to Sibling Diagram – используется для отображения 

следующей диаграммы того же уровня. 

 8. Go to Parent Diagram – переход на родительскую диаграмму. 

 9. Go to Child Diagram – используется, чтобы отобразить 

диаграмму  потомка или разложить выделенный блок на диаграмму 

потомка. 

 Построение модели системы должно начинаться с изучения 

всех документов, описывающих ее функциональные возможности. 

Одним из таких документов является техническое задание, а именно 

разделы «Назначение разработки», «Цели и задачи системы» и 

«Функциональные характеристики системы». 

 IDEF0-модель предполагает наличие четко сформулированной 

цели, единственного субъекта моделирования и одной точки зрения. 

Для внесения области, цели и точки зрения в модели IDEF0 в BPwin 

следует выбрать пункт меню Model/Model Properties, вызывающий 

диалог Model Properties (рисунок 3). 

 В закладке Purpose следует внести цель и точку зрения, а в 

закладку Definition – определение модели и описание области. В 

закладке Status того же диалога можно описать статус модели 

(черновой вариант, рабочий, окончательный и т.д.), время создания 

и последнего редактирования (отслеживается в дальнейшем 

автоматически по системной дате). В закладке Source описываются 

источники информации для построения модели (например, "Опрос 

экспертов предметной области и анализ документации"). Закладка 

General служит для внесения имени проекта и модели, имени и 

инициалов автора и  временных рамок. 

 

 
Рисунок 3. 

 

Работа с блоками и дугами 

 

 Методология IDEF0 предписывает построение иерархической 

системы диаграмм – единичных описаний фрагментов системы. 

Сначала проводиться описание системы в целом (контекстная 

диаграмма), после чего проводиться декомпозиция – система 

разбивается на подсистемы, и каждая подсистема описывается 

отдельно. 

 

Контекстная диаграмма 

 

 После создания проекта мы видим окно с единственным 

блоком. Назовем данный блок «Обслуживание клиента системы». 
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Для этого необходимо щелкнуть правой клавишей мыши по блоку и 

выбрать команду Name и в диалоговом окне ввести название 

(рисунок 2).  

 По отношению к тексту применимы стандартные способы 

форматирования, для их использования следует выполнить команду 

контекстно-зависимого меню Font. Вы можете изменять размеры 

блока. Для изменения высоты необходимо перетащить мышью 

верхнюю или нижнюю стороны блока, аналогично меняется размер 

по горизонтали. 

 После создания объекта необходимо обозначить его основные 

функции и элементы взаимодействия. В Bpwin этими элементами 

являются дуги. Для построения дуг управления, входа, выхода и 

механизмов необходимо выбрать инструмент (Arrow Tool), затем 

щелкнуть мышью со стороны периметра и второй щелчок с 

соответствующей стороны блока. Для построения дуги выхода 

щелкнуть первоначально справой стороны блока, затем со стороны 

периметра. 

 То с какой стороны дуга подходит к блоку является своего 

рода значением данной дуги. 

 Слева – вход в блок 

 Справа – выход в блок 

 Сверху – управляющая информация 

 Снизу – механизмы (средства производства) 

 Дугам, как и блокам можно придавать свои имена. Для этого 

необходимо: щелкнуть правой клавишей мыши по блоку и выбрать 

команду Name и в диалоговом окне ввести название дуги. 

 Для удаления блока и дуги или текста необходимо их  

выделить щелчком левой кнопки мыши и нажать клавишу Delete, а 

затем подтвердить намерения по поводу удаления. 

 

Декомпозиция 

 

 После создания контекстной диаграммы необходимо 

расписать работу отдельных участков. Для декомпозиции 

необходимо в браузере щелкнуть левой кнопкой мыши на имени 

 
Рисунок 2.  

  

диаграммы, а затем нажать кнопку (Go to Child Diagram), затем в 

диалоговом окне (рисунок 3) ввести необходимое количество блоков 

и тип диаграммы: 

 

  
Рисунок 3.  

 

 Если в дальнейшем необходимо добавить блоки на диаграмме, 

то необходимо выбрать инструмент (Activity Box Tool) и щелкнуть 

мышью в нужном месте диаграммы. 

 После декомпозиции необходимо соединить получившиеся 

блоки дугами. Для этого необходимо выбрать инструмент, щелкнуть 

мышью по исходной стороне блока затем по конечной стороне 

следующего блока. Аналогично строятся разветвления и слияния дуг. 
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ЗАДАНИЕ 

 

 Рассмотрим технологию ее построения на примере системы 

«Служба занятости в рамках вуза», основные возможности которой 

были описаны в лабораторной работе № 1. 

 Сформулируем цель моделирования: описать 

функционирования системы, которое было бы понятно ее 

пользователю, не вдаваясь в подробности, связанные с реализацией. 

Модель будем строить с точки зрения пользователей (студент, 

преподаватель, администратор, деканат, фирма). 

 Начнем с построения контекстной IDEF0-диаграммы. 

Согласно описанию системы основной функцией является 

обслуживание ее клиентов посредством 

обработки запросов, от них поступающих. Таким образом, определим 

единственную работу контекстной диаграммы как «Обслужить 

клиента системы». Далее определим входные и выходные данные, а 

так же механизмы и управление. 

 Для того чтобы обслужить клиента, необходимо 

зарегистрировать его в системе, открыть доступ к БД и обработать 

его запрос. В качестве входных данных будут использоваться «имя 

клиента», «пароль клиента», «исходная БД», «запрос клиента». 

 Выполнение запроса ведет либо к получению информации от 

системы, либо к изменению содержимого БД (например, при 

составлении экспертных оценок), поэтому выходными данными 

будут являться «отчеты» и «измененная БД». Процесс обработки 

запросов будет выполняться монитором системы под контролем 

администратора. 

 Таким образом, определим контекстную диаграмму системы 

(рисунок 4). 

 Проведем декомпозицию контекстной диаграммы, описав 

последовательность обслуживания клиента: 

 1. Определение уровня доступа в систему. 

 2. Выбор подсистемы. 

 3. Обращение к подсистеме. 

 4. Изменение БД (при необходимости). 

 Получим диаграмму, изображенную на рисунке 5. 

 Закончив декомпозицию контекстной диаграммы, переходят к 

декомпозиции диаграммы следующего уровня. Обычно при 

рассмотрении третьего и более нижних уровней модели 

возвращаются к родительским диаграммам и корректируют их. 

 Декомпозируем последовательно все блоки полученной 

диаграммы. Первым этапом при определении уровня доступа в 

систему является определение категории пользователя. По имени 

клиента осуществляется поиск в базе пользователей, определяя его 

категорию. Согласно определенной категории выясняются 

полномочия, предоставляемые пользователю системы. 

 Далее проводится процедура доступа в систему, проверяя имя 

и пароль доступа. Объединяя информацию о полномочиях и уровне 

доступа в систему, для пользователя формируется набор 

разрешенных действий. Таким образом, определение уровня доступа 

в систему будет выглядеть как показано на рисунке 6. 

 После прохождения процедуры доступа в систему монитор 

анализирует запрос клиента, выбирая подсистему, которая будет 

обрабатывать запрос. Декомпозиция работы «Обращение к 

подсистеме» не отвечает цели и точке зрения модели. Пользователя 

системы не интересуют внутренние алгоритмы ее работы. В данном 

случае ему важно, что выбор подсистемы будет произведен 

автоматически, без его вмешательства, поэтому декомпозиция 

обращения к подсистеме только усложнит модель. 

 Декомпозируем работу «Обработка запроса клиента», 

выполняемую подсистемой обработки запросов, определения 

категорий и полномочий пользователей. Перед осуществлением 

поиска ответа на запрос необходимо открыть БД (подключиться к 

ней). В общем случае БД может находиться на удаленном сервере, 

поэтому может потребоваться установление соединения с ней. 

Определим последовательность работ: 

 1. Открытие БД. 

 2. Выполнение запроса. 

 3. Генерация отчетов. 

 После открытия БД необходимо сообщить системе об 

установлении соединения с БД, после чего выполнить запрос и 

сгенерировать отчеты для пользователя (рисунок 7). Перейдем к 

декомпозиции последнего блока «Изменение БД» (рисунок 8). 
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Рисунок 4. Контекстная диаграмма системы 
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Рисунок 5. Декомпозиция работы «Обслуживание клиента системы» 
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Рисунок 6. Декомпозиция работы «Определение уровня доступа в систему» 
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Рисунок 7. Декомпозиция работы «Обработка запроса клиента» 
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Рисунок 8. Декомпозиция работы «Изменение базы данных» 
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Практическая работа №3 

Создание контекстной диаграммы и проведение декомпозиции 

 
Задание: Построить модель по образцу 

 

 
Рисунок 1 
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Рисунок 2. 
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Практическая работа №4 

Дополнение моделей процессов диаграммами DFD 
потоков данных (Data Flow Diagrams) используются для описания 

документооборота и обработки информации. Подобно IDEF0, DFD 

представляет модельную систему как сеть связанных между собой 

работ. 

 DFD описывает: 

 1. функции обработки информации (работы); 

 2. документы (стрелки, arrow), объекты, сотрудников или 

отделы, которые участвуют в обработке информации; 

 3. внешние ссылки (external reference), которые обеспечивают 

интерфейс с внешними объектами, находящимися за границами 

моделируемой системы; 

 4. таблицы для хранения документов (хранилиш;а данных, data 

store). 

 Для построения диаграмм DFD в BPWin используется нотация 

Гейна - Сарсона (таблица 1). 

 

Таблица 1 

 
 

 Создание диаграммы DFD. 

 Для создания диаграммы DFD необходимо в диалоге New 

Model (рисунок 1) выбрать кнопку DFD. 

  

 

 

 

 Пример 1. Диаграммы DFD можно использовать как 

дополнение к диаграммам IDEF0 для описания документооборота и 

обработки информации. Рассмотрим работу «Обработка запросов 

клиента» из лабораторной работы №1. 

 Запросы в систему поступают от пользователей, поэтому 

запросы от каждой категории будут обрабатываться отдельно. 

Выделим внешние сущности диаграммы согласно каждой категории 

пользователей, определяя потоки данных, которыми они 

обмениваются с системой. Получим диаграмму, изображенную на 

рисунке 2. 

 Согласно описанию системы проведем декомпозицию 

полученных блоков (рис. 3 - 6). 

 Все процессы обработки запросов контролируются и 

выполняются монитором системы, поэтому стрелка-механизм 

«Монитор системы» будет повторяться на декомпозированных 

диаграммах. Точка зрения модели, определенная в лабораторной 

работе № 1, не требует рассмотрения внутренних особенностей 

функционирования системы, поэтому затуннелируем стрелку 

«Монитор системы» с тем, чтобы не переносить ее на диаграммы 

нижнего уровня. 

 Проведем анализ полученных диаграмм. Рассматривая 

диаграмму, изображенную на рисунке 2, необходимо отметить 

наличие в ней лишнего блока «Обработать запрос администратора». 

 Администратор не обслуживается системой как обычный 

клиент, он обеспечивает ее мониторинг. Администратор может 

добавлять пароли, изменять уровень доступа в систему, добавлять 

нового пользователя и т. д. С точки зрения клиента системы, 

деятельность администратора является второстепенной, поэтому на 

всех диаграммах отсутствует описание функций администратора, 

представляя его влияние как «механизм» для других функций. 

Поэтому принимаем решение удалить работу «Обработать запрос 

администратора». 
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Рисунок 2. DFD-декомпозиция работы «Выполнение запроса» 
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Рисунок 3   Декомпозиция работы «Обработать запрос студента» 
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Рисунок 4  Декомпозиция работы «Обработать запрос декана» 
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Рисунок 5  Декомпозиция работы «Обработать запрос фирмы» 
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Рисунок  6. Декомпозиция работы «Обработать запрос эксперта»
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3 Методические указания по самостоятельной работе  

 

Для успешного освоения курса «Организационное обеспечение 

автоматизированных систем» необходима самостоятельная работа. В настоящее время 

актуальными становятся требования к личным качествам современного студента – 

умению самостоятельно пополнять и обновлять знания, вести самостоятельный поиск 

необходимого материала, быть творческой личностью.  

Самостоятельную работу по освоению дисциплины обучающимся следует 

начинать с изучения содержания рабочей учебной программы дисциплины, цели и задач, 

структуры и содержания курса, основной и дополнительной литературы, 

рекомендованной для самостоятельной работы. 

Самостоятельная учебная деятельность является необходимым условием 

успешного обучения. Многие профессиональные навыки, способность мыслить и 

обобщать, делать выводы и строить суждения, выступать и слушать других, – все это 

развивается в процессе самостоятельной работы студентов.  

Самостоятельная работа по освоению дисциплины включает:  

  - самостоятельное изучение разделов; 

 - самоподготовку (проработку и повторение лекционного материала и материала 

учебников и учебных пособий); 

 - подготовку к лабораторным работам; 

 - подготовку к рубежному и итоговому контролю. 

Самостоятельная учебная работа – условие успешного окончания высшего 

учебного заведения. Она является равноправной формой учебных занятий, наряду с 

лекциями, семинарами, экзаменами и зачетами, но реализуемая во внеаудиторное время.  

Эффективность аудиторных занятий во многом зависит от того, насколько умело 

студенты организуют в ходе них свою самостоятельную учебную познавательную 

деятельность. Такая работа также способствует самообразованию и самовоспитанию, 

осуществляемому в интересах повышения профессиональных компетенций, общей 

эрудиции и формировании личностных качеств.  

Самостоятельная работа реализуется: 

1. непосредственно в процессе аудиторных занятий – на лекциях, лабораторных 

занятиях, при проведении рубежного контроля; 

2. в контакте с преподавателем вне рамок расписания – на консультациях по 

учебным вопросам, при ликвидации задолженностей, при выполнении индивидуальных 

заданий; 

3. в библиотеке, дома, в общежитии, на кафедре при выполнении студентом 

учебных  задач. 

В процессе проведения самостоятельной работы необходимо производить подбор 

литературных источников, научной периодической печати и т.д  

 

4 Методические указания по итоговому контролю 

 

Итоговый контроль знаний по дисциплине «Организационное обеспечение 

автоматизированных систем» проводится в форме зачета. Для подготовки к итоговому 

контролю знаний по дисциплине «Организационное обеспечение автоматизированных 

систем» обучающиеся используют перечень вопросов, приведенный в фонде оценочных 

средств. Зачет проводится в устной форме. В экзаменационный билет включен один 

теоретический вопрос. На подготовку студенту отводится 20-25 минут. На 

дифференцированном зачете ответы обучающегося оцениваются с учетом их полноты, 

правильности и аргументированности с учетом шкалы оценивания. 

Оценка «отлично» выставляется студенту, если он глубоко и прочно усвоил 

программный материал, исчерпывающе, последовательно, четко и логически его излагает, 



30 

умеет тесно увязывать теорию с практикой, свободно справляется с вопросами и другими 

видами применения знаний, причем не затрудняется с ответом при видоизменении 

заданий, использует в ответе профессиональные термины, правильно обосновывает 

принятое решение. 

Оценка «хорошо» выставляется студенту, если он твердо знает материал, грамотно 

и по существу излагает его, не допуская существенных неточностей в ответе на вопрос, 

правильно применяет теоретические положения при решении практических вопросов, 

владеет необходимыми навыками и приемами их выполнения. 

Оценка «удовлетворительно» выставляется студенту, если он имеет знания только 

основного материала, но не усвоил его деталей, допускает неточности, недостаточно 

правильные формулировки, нарушения логической последовательности в изложении 

программного материала. 

Оценка «неудовлетворительно» выставляется студенту за отсутствие знаний по 

дисциплине, представления по вопрос, непонимание материала по дисциплине, наличие 

коммуникативных «барьеров» в общении, отсутствие ответа на предложенный вопрос. 

 

5 Учебно-методическое обеспечение дисциплины 

 

5.1 Основная литература 

 

1. Золотов, С.Ю. Проектирование информационных систем : учебное пособие / 

С.Ю. Золотов ; Министерство образования и науки Российской Федерации, Томский 

Государственный Университет Систем Управления и Радиоэлектроники (ТУСУР). - Томск 

: Эль Контент, 2013. - 88 с. : табл., схем. - ISBN 978-5-4332-0083-8 ; То же [Электронный 

ресурс]. - URL: //biblioclub.ru/index.php?page=book&id=208706, коэффициент 

книгообеспеченности 0,8 

2. Стасышин, В.М. Проектирование информационных систем и баз данных : 

учебное пособие / В.М. Стасышин. - Новосибирск : НГТУ, 2012. - 100 с. - ISBN 978-5-

7782-2121-5 ; То же [Электронный ресурс]. - 

URL: //biblioclub.ru/index.php?page=book&id=228774, коэффициент книгообеспеченности 

0,8 

 

5.2 Дополнительная литература 

1.  Проектирование информационных систем [Текст] : учебное пособие / Г. Н. 

Исаев.- 2-е изд., стер. - Москва : Омега - Л, 2015. - 424 с. - (Высшее техническое 

образование) - ISBN 978-5-370-03507-4.  (ОГТИ СПО 16), коэффициент 

книгообеспеченности 1 

2. Абрамов, Г.В. Проектирование информационных систем : учебное пособие / 

Г.В. Абрамов, И.Е. Медведкова, Л.А. Коробова. - Воронеж : Воронежский 

государственный университет инженерных технологий, 2012. - 172 с. : ил.,табл., схем. - 

ISBN 978-5-89448-953-7 ; То же [Электронный ресурс]. - 

URL: //biblioclub.ru/index.php?page=book&id=141626, коэффициент книгообеспеченности 

1 

3. Заика, А.А. Разработка прикладных решений для платформы 1С:Предприятие 8.2 

в режиме «Управляемое приложение» / А.А. Заика. - 2-е изд., испр. - М. : Национальный 

Открытый Университет «ИНТУИТ», 2016. - 239 с. : ил. ; То же [Электронный ресурс]. - 

URL: //biblioclub.ru/index.php?page=book&id=429019 , коэффициент книгообеспеченности 

1. 

5.3 Периодические издания 

1. Журнал «Вестник компьютерных и информационных технологий » 

2. Журнал «Информационные технологии и вычислительные системы» 

3. Журнал «Стандарты и качество» 
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4. Журнал «Прикладная информатика» 

 

             5.4 Интернет-ресурсы 

 

5.4.1 Современные профессиональные базы данных и информационные 

справочные системы: 
 

1. Информационная система «Единое окно доступа к образовательным ресурсам»- 

http://window.edu.ru/ 

2. КиберЛенинка - https://cyberleninka.ru/ 

3. Университетская информационная система Россия– uisrussia.msu.ru 

4. Бесплатная база данных ГОСТ– https://docplan.ru/ 
 

5.4.2 Тематическиепрофессиональные базы данных и информационные 

справочные системы:     

1. Портал искусственного интеллекта – AIPortal      

2. Web-технологии – Web-технологии       

3. Электронная библиотека Института прикладной математики им. М.В. Келдыша 

– Электронная библиотека публикаций Института прикладной математики им. М.В. 

Келдыша РАН         

 

5.4.3 Электронные библиотечные системы 

 

1. ЭБС «Университетская библиотека онлайн» – http://www.biblioclub.ru/ 

 2. ЭБС Znanium.com – https://znanium.com/ 

5.4.4 Дополнительные Интернет-ресурсы 

 

1. https://www.ixbt.com - Интернет-издание о компьютерной технике, 

информационных технологиях и программных продуктах. На сайте публикуются новости 

IT, статьи с обзорами и тестами компьютерных комплектующих и программного 

обеспечения. 

2. http://www.intuit.ru – ИНТУИТ – Национальный открытый университет. 

3.  http://cppstudio.com/ - Основы программирования на языках Си и C++. 

4. http://citforum.ru/SE/project/arkhipenkov_lectures – Лекции по управлению 

программными проектами автор А. Архипенков 

 

5.5 Программное обеспечение, профессиональные базы данных и 

информационные справочные системы современных информационных технологий 

 

Тип программного обеспечения Наименование Схема лицензирования, режим доступа 

Операционная система 
Microsoft 

Windows 

Подписка Enrollment for Education 

Solutions (EES) по государственному 

контракту: 

№ 2К/17 от 02.06.2017 г.; 

Текстовый редактор Notepad++ 
Свободное ПО, 

https://notepad-plus-plus.org/ 

Интернет-браузер Google Chrome 
Бесплатное ПО, 

http://www.google.com/intl/ru/policies/terms/ 
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Векторный графический 

редактор, редактор диаграмм и 

блок-схем 

Microsoft Visio 

Standard 2007 

Сертификат MicrosoftOpenLicense 

№ 46284547 от 18.12.2009 г., 

академическая лицензия на рабочее место 

Интегрированная среда 

разработки программного 

обеспечения 

Microsoft Visual 

Studio 

Professional 

2008 

Сертификат MicrosoftOpenLicense 

№ 46284547 от 18.12.2009 г., 

академическая лицензия на рабочее место 

Embarcadero 

RAD Studio 

2010 

Professional 

Образовательная лицензия по 

государственному контракту № 32/09 от 

17.12.2009 г., сетевой конкурентный 

доступ 

Turbo Pascal 7.0 

for DOS 

Образовательная лицензия по 

государственному контракту № 34/10 от 

10.12.2010 г., лицензия на рабочее место 

Borland C++ 3.1 

for DOS 

Образовательная лицензия по 

государственному контракту № 34/10 от 

10.12.2010 г., лицензия на рабочее место 

Dev-C++ 
Свободное ПО, 

http://www.gnu.org/licenses/gpl.html 

 

6 Материально-техническое обеспечение дисциплины  

Учебные аудитории для проведения занятий лекционного типа, семинарского типа, 

для проведения групповых и индивидуальных консультаций, текущего контроля и 

промежуточной аттестации. Для проведения лабораторных работ используются 

компьютерный класс (ауд. № 4-113, 4-116, 4-117), оборудованный средствами оргтехники, 

программным обеспечением, персональными компьютерами, объединенными в сеть с 

выходом в Интернет.  

Аудитории оснащены комплектами ученической мебели, техническими средствами 

обучения, служащими для представления учебной информации большой аудитории. 

Помещения для самостоятельной работы обучающихся оснащены компьютерной 

техникой, подключенной к сети «Интернет», и обеспечением доступа в электронную 

информационно-образовательную среду Орского гуманитарно-технологического 

института (филиала) ОГУ (ауд. № 4-307). 

 

Наименование помещения Материальное-техническое обеспечение 

Учебные аудитории: 

- для проведения занятий лекционного 

типа, семинарского типа,  

- для групповых и индивидуальных 

консультаций; 

- для текущего контроля и 

промежуточной аттестации 

Учебная мебель, классная доска, 

мультимедийное оборудование (проектор, 

экран, ноутбук с выходом в сеть «Интернет») 

Компьютерные классы № 4-113, 4-116, 

4-117 

 

Учебная мебель, компьютеры (29) с выходом в 

сеть «Интернет», проектор, экран, лицензионное 

программное обеспечение 

Помещение для самостоятельной 

работы обучающихся, для курсового 

проектирования (выполнения курсовых 

работ) 

Учебная мебель, компьютеры (3) с выходом в 

сеть «Интернет» и обеспечением доступа в 

электронную информационно-образовательную 

среду Орского гуманитарно-технологического 

института (филиала) ОГУ, программное 

обеспечение 
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Для проведения занятий лекционного типа используются следующе наборы 

демонстрационного оборудования и учебно-наглядные пособия: 

- презентации к курсу лекций 

 


